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  Sovellusohjelma Raspberry Pi 3 -alustalle 

Sulautettujen järjestelmien kehitys on tänä päivänä voimakkaasti kasvava tietotekniikan ala, 
johon erityisesti Internet of Things (IoT, esineiden Internet) avaa valtavat kehitysnäkymät. 
Opinnäytetyö liittyy keskeisesti juuri tähän tietotekniikan haaraan, ja aiheena on Yocto SDK 
(Software Development Kit) -sovelluskehitysympäristön asennus ja käyttö. Ohjelmointi ei 
varsinaisesti kuulunut opinnäytetyön piiriin, vaan ainoastaan hyvin pieni esimerkkiohjelma luotiin 
ja testattiin Raspberry Pi 3 -minitietokoneella. Työssä lähdettiin liikkeelle Yocto SDK:n 
asennustiedoston luomisesta Yocto-projektin työvälineillä, mutta itse Yocto-projektin asennus 
oletettiin jo ennalta suoritetuksi. Yocto-projekti ja Yocto SDK:n uusin versio ovat toiminnoiltaan 
keskenään lähes vastaavia, joskin Yocto SDK on enemmän suunniteltu nimenomaan 
sovellusohjelmien kehitykseen ja Yocto-projekti käyttöjärjestelmien luomiseen. Uusimmat 
versiot näistä järjestelmistä kykenevät molempiin tehtäviin, eikä ero näiden kahden välillä ole 
suuri. 

Opinnäytetyössä Yocto SDK asennettiin Linux Ubuntu 18.04 -järjestelmään Yocto-projektilla 
luodun asennustiedoston avulla. Yocto SDK:n asentamisen jälkeen luotiin sen avulla ensin 
käyttöjärjestelmäydin ja tiedostojärjestelmä testiympäristöä ja kohdelaitteistoa varten, joita tässä 
tapauksessa olivat Quick Emulator (Qemu) ja Raspberry Pi 3 B+. Qemu on virtuaalinen, 
ohjelmallisesti toteutettu fyysistä laitetta jäljittelevä (emuloiva) sovellus, jota käytettiin 
ohjelmakoodin testaukseen. 

Sovellusohjelman kehitykseen käytettiin erillistä Eclipse IDE -ohjelmointityökalua, joka 
integroitiin Yocto SDK -kehitysympäristöön Yocto-lisäosan (engl. plug-in) avulla. 
Ohjelmointivaiheessa koodi käännettiin ja ladattiin Eclipse IDE:n debug-komentoa käyttäen 
suoraan Qemu-järjestelmään testattavaksi. Kun testausvaihe oli suoritettu onnistuneesti, luotiin 
Yocto SDK:n devtool add -komennolla resepti (engl. recipe) suoraan Eclipse IDE:n 
projektitiedostoista. Resepti tarkoittaa tässä yhteydessä järjestelmälle annettavaa ohjeistusta 
siitä, miten tietty ohjelmistopaketti kootaan. Resepti on vastaava, kuin mitä Yocto-projektissakin 
käytetään, ja sen avulla voidaan ohjelma kääntää ja asentaa laitteelle tai liittää se 
muodostettavaan uuteen käyttöjärjestelmään. Viimeisenä vaiheena luotiin bitbake-ohjelmalla 
Yocto-kerros (layer), jonne devtool finish -komennolla lisättiin uuden ohjelman resepti lopullista 
varastointia ja myöhempää käyttöä varten eri projekteihin liitettäväksi. 

ASIASANAT: 

sovelluskehitys, sulautettu, järjestelmä, kehitystyökalu, ohjelmointi  
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YOCTO PROJECT AND SOFTWARE 
DEVELOPMENT FOR EMBEDDED SYSTEMS 

 Application for Raspberry Pi 3 

The development of embedded systems today is a rapidly growing area of information 
technology and, in particular, the Internet of Things (IoT) opens up huge prospects for it. The 
thesis is mainly related to this branch of information technology and the objectives of the thesis 
were to install and use a Yocto SDK (Software Development Kit) environment. Programming 
was not within the scope of this thesis. Only a very small sample program was created and 
tested for the Raspberry Pi 3 minicomputer. 

The work started with creating a Yocto SDK installation file with the tools of the Yocto project. It 
is assumed that Yocto project itself has been pre-installed. The Yocto project and the latest 
version of Yocto SDK are almost the same in terms of functionality, although the Yocto SDK is 
more specifically designed for software development and Yocto project for creating operating 
systems. Nevertheless the latest versions of both are capable of performing these tasks and the 
difference between them is not notable. 

In the thesis, the Yocto SDK was installed on Linux Ubuntu 18.04 using the installation file 
created by the Yocto project. Once installed, the Yocto SDK was first used to create the 
operating system kernel and the file system for the test environment and the target hardware, in 
this case Quick Emulator (Qemu) and Raspberry Pi. Qemu is a virtual device, an application 
that emulates a physical device, used for testing the program. 

Eclipse IDE is a programming tool used in this thesis for software development. It is separate 
from the Yocto SDK but a plug-in is available for integrating it to the Yocto SDK development 
environment. In the coding and testing phase the software was compiled and loaded directly 
into Qemu using the Eclipse IDE debug feature. 

Once the testing was successful, a recipe was created directly from the Eclipse IDE project files 
with the Yocto SDK devtool add -command. Recipes are instructions for the system of how to 
proceed in creating a certain software package. The Yocto SDK recipe is corresponding to the 
Yocto project recipe, and it can be used for compiling and installing the program directly on the 
device or adding it to the operating system when creating it. In this project the program was 
installed on Raspberry Pi device by the devtool deploy-target –command as a final step to 
ensure that it works on a physical device as well. As a final step the devtool recipe was 
transformed to a Yocto recipe with the devtool finish command, and was so exported for storing 
it in a repository, and to be subsequently used in various projects. 

 

KEYWORDS: 

application, development, embedded, system, programming   
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ALKULAUSE 

Tämä opinnäytetyö on kirjoitettu suomen kielellä, vaikka englannin kieli olisi monilta 

osin ollut luontevampi vaihtoehto mm. terminologian osalta. Tietotekniikan alalla ja eri-

tyisesti sulautetuissa järjestelmissä käytetty terminologia on erityislaatuista ja osin vai-

keaa kääntää suomeksi. Omalla äidinkielellä kirjoittaminen taas muuten on helpompaa 

ja sujuvampaa, ja siksi tässä opinnäytetyössä on päädytty kielen osalta juuri suomen 

kieleen. Lukijoille (kuten myös tämän kirjoittajalle) saattaa kuitenkin olla vaikea ymmär-

tää joidenkin ilmaisujen tarkkaa merkitystä suomen kielellä, jos ne ovat pääosin tulleet 

tutuiksi juuri englannin kielellä. 

Edellä mainituista syistä johtuen tässä työssä on monia asioita pyritty selventämään 

sanallisesti paitsi suomeksi, myös laittamalla tärkeiden teknisten termien ja ilmaisujen 

perään sulkeisiin sama asia englannin kielellä. Suomenkieliset käännökset eivät usein-

kaan ole vielä täysin vakiintuneita tai ovat harvoin käytettyjä. Englanninkielisen termin 

kautta lukija voi varmistua käytetyn suomenkielisen vastineen merkityksestä kuten 

esim. ristikehitys (cross-development). Niinpä tässä opinnäytetyössä ei ole nähty tar-

peelliseksi koota mitään erityistä lyhenneluetteloa tai erikoissanastoa, koska asiat ja 

ilmaisut selvennetään tekstin yhteydessä. 

Monissa kohdin englanninkielinen termi on jonkin järjestelmän tai toiminnon nimi, jolloin 

sen suomentaminen ei edes ole tarpeen. Tällaisia ovat esimerkiksi juuri otsikossa 

esiintyvä nimi Yocto tai tämän työn varsinainen aihe ”Yocto Software Development Kit”, 

joka on hyvin vakiintunut nimi tai käsite juuri englanninkielisissä materiaaleissa ja siksi 

sen käyttö sellaisenaan kertoo tarkimmin mistä puhutaan. Lyhyyden vuoksi tässä työs-

sä käytetään pääasiassa kuitenkin muotoa Yocto SDK. Tässä työssä käytetään myös 

suomennosta ohjelmistokehitysjärjestelmä tai -kehitysympäristö, vaikka sana ”kit” tar-

koittaakin varsinaisesti ”varusteet” tai ”tarvikkeet”. Kyse on kuitenkin hyvin kattavasta 

kokonaisuudesta, joten sana järjestelmä tai ympäristö on perusteltu 

Vastaavia nimiksi katsottavia termejä ovat OpenEmbedded ja Poky, mutta joidenkin 

kohdalla rajan vetäminen ei ole niin helppoa. Qemu (Quick Emulator) voitaisiin suo-

mentaa sanalla ”pikajäljittelijä” tai ”pikaemulaattori”, mutta se ei tunnu luontevalta, ja 

siksi onkin katsottu paremmaksi käyttää termiä Qemu.  
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1 JOHDANTO 

Tämä opinnäytetyö liittyy maailmalla valtavassa kasvuvaiheessa olevaan IoT (Internet 

of Things, esineiden Internet) -teknologiaan [1,2] ja sulautettujen järjestelmien kehitys-

työhön. Työssä perehdytään sulautettuihin järjestelmiin asennettavien sovellusten kehi-

tykseen ja asennukseen Yocto SDK (Yocto Software Development Kit)  

-kehitysympäristön avulla. Varsinainen ohjelmointi ei kuulu tämän työn tavoitteisiin, 

vaan ainoastaan itse kehitysympäristön asennus ja käyttöönotto. Esimerkin ja testauk-

sen vuoksi toteutetaan kuitenkin hyvin yksinkertainen ohjelma. Tavoitteena on asentaa 

Yocto SDK sekä tähän integroitava erillinen ohjelmointityökalu Eclipse IDE (Eclipse 

Integrated Development Environment).  

Yocto SDK liittyy olennaisesti laajaan sulautettujen järjestelmien kehitysympäristöön 

nimeltä Yocto Project, johon nimikin jo selvästi viittaa. Kyse onkin miltei samasta tai 

samankaltaisesta järjestelmästä, mutta nämä on silti syytä erottaa toisistaan. Tässä 

työssä viitataan usein Yocto-projektiin ja hieman siihen perehdytäänkin, sillä se on läh-

tökohta ja perusta koko opinnäytetyölle. Lisäksi käydään läpi Eclipse IDE  

-ohjelmointityökalun integrointi Yocto SDK -kehitysympäristöön, mikä osaltaan tuo lisä-

ulottuvuuksia tämän järjestelmän käyttöön. 

Sulautettujen järjestelmien kirjo on laaja, ja erilaisia laitteita ja laitteistoarkkitehtuureja 

on tarjolla moniin eri tarkoituksiin [3]. Sovellusten kohdejärjestelmä (engl. target sys-

tem) on se, mihin ympäristöön kehitettävä sovellus lopulta asennetaan. Sulautetut jär-

jestelmät ovat yleensä resursseiltaan tavallista PC-tietokonetta rajoitetumpia (työmuisti, 

prosessoriteho, pysyvä muisti eli ns. kovalevy) [1,4]. Nämä järjestelmät ovat usein 

myös suunniteltuja vain johonkin tiettyyn tarkoitukseen, eikä käyttäjä voi aina valita, 

miten järjestelmä toimii tai mitä ohjelmia siihen asennetaan. Myös monia muita rajoi-

tuksia voi liittyä näihin järjestelmiin [5], mutta tarkempi perehtyminen niihin ei kuulu 

tämän työn aihepiiriin. 

Tässä työssä kohdejärjestelmänä tai -laitteena käytettiin kuvassa 1 esitettyä ja maail-

malla valtaisan suosion saanutta Raspberry Pi -piiriä. Se voidaan oikeastaan määritellä 

jo pieneksi tietokoneeksi, sillä se on teholtaan ja ominaisuuksiltaan hyvin lähellä perin-

teisiä kotitietokoneita [6]. 
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Kuva 1. Raspberry Pi -piiri (kuva R. Vesti). 

Raspberry Pi on noin luottokortin kokoinen piiri [6], jossa prosessorin lisäksi on useita 

normaalista PC-tietokoneestakin löytyviä I/O portteja kuten USB, Ethernet, HDMI, WiFi 

ja Bluetooth [7]. Kyseinen laite on ensimmäisen, v. 2011 myydyn tuotantoerän jälkeen 

käynyt läpi muutamia kehitysvaiheita, ja uusin malli 3 B+ on tässä opinnäytetyössä 

käytetty versio. Raspberry Pi on monipuolisten ominaisuuksiensa vuoksi hyvin käyttö-

kelpoinen monenlaisissa tehtävissä. Nykyään erityisesti IoT-järjestelmissä sitä käyte-

tään mm. ohjaimena (engl. controller) sekä monissa muissa tehtävissä [8]. IoT on niin 

ikään erittäin voimakkaasti kasvava tietotekniikan ala, ja verkkoon liitettävien uusien 

laitteiden määrä kasvaa kiihtyvällä nopeudella [1]. Siksi myös sovelluskehitysjärjestel-

mä Yocto SDK on hyvin keskeisessä asemassa tällä kasvavalla alalla, ja sovellusten 

kehittäminen Raspberry Pi -piiriin laajentaa sen käyttömahdollisuuksia. 

Sulautetuissa järjestelmissä on käyttöjärjestelmänä nykyään yhä useammin Linux eikä 

enää välttämättä laitevalmistajan itse kehittämä järjestelmä [4], kuten aiemmin oli yleis-

tä. Raspberry Pi -piiriä myydään joko ilman mitään käyttöjärjestelmää tai siten, että 

mukana on esim. Raspbian-niminen versio Linux Debian -jakelusta [7]. Linux onkin 

ollut yksi merkittävä vaikuttaja myös Raspberry Pi -piirin suosion huimaan nousuun. 

Tämä johtuu paljolti Linuxin vapaasta saatavuudesta, käytöstä ja kehityksestä Gnu 

GPL -lisenssin alla sekä myös valtavasta maailmanlaajuisesta ohjelmistokehittäjien 

yhteisöstä, joka tukee Linuxin eri versioiden kehitystä. 

Tässä työssä Linux-käyttöjärjestelmä Raspberry Pi -piirille luotiin samalla Yocto SDK 

-järjestelmällä, jolla muitakin sovelluksia kehitetään. Käytännössä Yocto SDK on omi-
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naisuuksiltaan niin monipuolinen, ettei varsinaista Yocto-projektia enää välttämättä 

tarvita. Tämä eri järjestelmien kokonaisuus on hyvin laaja, eikä sitä voida tässä yksi-

tyiskohtaisesti käydä läpi. Lyhyesti sanottuna tämä opinnäytetyö lähtee siitä, että Yoc-

to-projekti on valmiiksi asennettuna Linux Ubuntu 18.04 -käyttöjärjestelmään, ja siinä 

ympäristössä luodaan erillinen asennustiedosto (asennusskripti) Yocto SDK  

-kehitysympäristön asentamista varten. Tämä asennustiedosto siirretään ja suoritetaan 

toisessa tietokoneessa (tässä tapauksessa Oracle VirtualBox), jossa on sama käyttö-

järjestelmä ja jolla sitten varsinaisesti työskennellään siitä eteenpäin. Yocto-projektia ei 

enää tämän jälkeen käytetä. Kuvan 2 kaaviossa on hahmoteltu pääpiirteittäin miten 

Yocto-projektin sisältävällä järjestelmällä luodaan SDK-kehitysympäristö. 

 

Kuva 2. Kuvassa on hahmoteltu järjestelmän ”työnjako” eri yksiköiden välillä.  Kohta 1 kuvaa 
järjestelmää, johon on asennettu Yocto-projekti, ja jossa luodaan asennustiedosto SDK 
-kehitysympäristöä (kohta 2) varten. Kohdassa 3 (Target Device) on kohdelaite, mihin kehitettä-
vät sovellukset (Target Applications) lopulta asennetaan [9]. 

Yocto-projektilla luodaan ensin asennustiedosto komennolla bitbake <imagename> -c 

populate_sdk_ext, ja sitten kyseinen tiedosto siirretään ja asennetaan kokonaan eri 

laitteelle (SDKMACHINE). Tämän jälkeen SDK:n kehitystyökaluilla luodaan sovelluksia 
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(Target Applications) kohdelaitteelle (Target Device). Kuvassa 2 esitetään, miten varsi-

nainen käyttöjärjestelmä (Target Image) kohdelaitteelle luodaan Yocto-projektilla. Tuo 

käyttöjärjestelmä voidaan kyllä luoda myös SDK:n työvälineillä ilman Yocto-projektia 

(punainen nuoli), ja näin tässä opinnäytetyössä meneteltiinkin.  Tämä pätee tosin vain 

uudempaan Extensible SDK (eSDK) -versioon, jolla voidaan luoda sekä sovelluksia 

että koko käyttöjärjestelmä (ks. luku 2.2). Kuvassa 2 käytetäänkin nimenomaan uu-

dempaa eSDK-versiota, sillä bitbake-komennon lopussa on pääte _ext, joka viittaa juuri 

siihen. Näillä työkaluilla voidaan tietenkin toimia hyvin monella tavalla, joko yhdessä tai 

erikseen, riippuen käyttäjän tarpeista ja mahdollisuuksista.  

Tämän opinnäytetyön tarkoituksena on käydä läpi ohjelmistotuotannon eri vaiheet: 

 Yocto SDK -järjestelmän asennustiedoston luominen 

 Yocto SDK -järjestelmän asennus 

 Eclipse IDE:n asennus ja integrointi Yocto SDK -järjestelmään 

 pienen esimerkkiohjelman luominen Eclipse IDE:n avulla 

 ohjelmakoodin testaus Qemu-virtuaalilaitteella ohjelmoinnin yhteydessä 

 ohjelman asennus kohdelaitteelle (Raspberry Pi) sekä toiminnan testaus 

 työn viimeistely luomalla ohjelmaprojektista Yocto-resepti (engl. recipe) myö-

hempää käyttöä varten. 
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2 TAUSTAA 

Johdannossa mainittujen asioiden ja tekniikoiden tarkempi esittely on tarpeen koko-

naiskuvan saamiseksi tämän opinnäytetyön päämäärästä ja menetelmistä. Sulautettu-

jen järjestelmien ala on maailmanlaajuinen ja voimakkaasti kehittyvä niin fyysisten lait-

teiden kuin ohjelmistojenkin osalta. Uusia yhä pienempiä ja tehokkaammilla prosesso-

reilla varustettuja laitteita kehitetään ja ohjelmia niiden hyödyntämiseksi tarvitaan. Linux 

käyttöjärjestelmän synty ja kehitys (alkaen vuodesta 1991) ajoittuu sopivasti tähän ko-

konaisuuteen, sillä Linux on osoittautunut hyvin mukautuvaksi erilaisiin laitearkkitehtuu-

reihin ja -ympäristöihin. Sen käyttö sulautetuissa järjestelmissä on kasvattanut suosio-

taan, ja yhä useammassa laitteessa tänä päivänä toimii Linux [4]. Linux-järjestelmästä 

on useita eri versioita, samoin kuin niiden kehitykseen on myös monenlaisia työkaluja. 

2.1 Yocto-projekti kokoaa yhteen Linuxin kehitystyövälineet 

Yocto-projekti on avoimen lähdekoodin laaja yhteistyöhanke, joka sisältää paljon erilai-

sia valmiita malleja, työkaluja ja menetelmiä Linuxiin pohjautuvien sulautettujen järjes-

telmien luomiseen riippumatta laitteiston arkkitehtuurista [9,10]. Yocto-projekti on 

eräänlainen kattonimike tai sateenvarjo kokoelmalle erilaisia tekniikoita ja työvälineitä. 

Projektia johtaa ja tukee Linux Foundation, jonka toimesta se myös perustettiin v. 2010 

[10]. Se on enemmän kuin vain ohjelmakoodin käännöstyökalu, sillä se mahdollistaa 

sekä käyttöjärjestelmän että siihen liittyvien sovellusten kehittämisen, testaamisen ja 

virheenkorjauksen (engl. debug). Yocto-projektin kolme tärkeintä osa-aluetta ovat oh-

jelmakoodin käännösjärjestelmä (engl. build system), ohjelmapakettien käännösohjeis-

tot (engl. package meta-data) sekä kehitystyökalut (engl. developer tools). Yocto 

-projektin kaksi merkittävintä komponenttia ovat Poky ja Bitbake [10]. 

 Poky (ohjelmakoodin käännösjärjestelmä) 

 Bitbake (käännös- ja koontiprosessin hallintaohjelma, ”Scheduler”) 

Yocto-projektin syntymisen taustalla on n. vuonna 2003 alkanut OpenEmbedded  

-projekti, joka sulautui Yocto-projektiin, kun Linux Foundation lokakuussa 2010 julisti 

Yocto-projektin syntyneeksi [11]. Poky oli hieman vastaava mutta oma kehityshaaran-

sa, joka myös liitettiin Yocto-projektiin. Useita Linuxin kehitykseen liittyviä työvälineitä ja 

ohjelmakirjastoja ym. (kuva 3), on sulautettu yhdeksi kehitysympäristöksi nimeltä Yocto 
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Project, joka on aktiivisen kehitystyön kohteena ja johon tulee uusia lisäyksiä ja muu-

toksia säännöllisesti. 

 

Kuva 3. Yocto-projektiin sulautetut eri osa-alueet menevät osittain päällekkäin [12]. 

 2.1.1 Yocto-projektin tärkeimmät kehitystyökalut 

Yocto-projektin tärkeimmät kehitystyökalut ja niiden käyttötarkoitukset [12] ovat seuraa-

vat: 

 CROPS sisältää kehitysympäristön binääritiedostojen luomiseen erilaisille lai-

tearkkitehtuureille ja käyttöjärjestelmille (Windows, Linux, Mac OS) 

 

 Devtool on komentoriviltä käytettävä työkalu ohjelmien kääntämiseen, tes-

taamiseen ja kokoamiseen. Se on hyvin keskeinen osa Extensible SDK 

(eSDK) -järjestelmää, jota myös tässä opinnäytetyössä käytettiin. 

 

 Extensible Software Development Kit (eSDK) sisältää työkalukokonaisuuden 

mm. ohjelmien ristikehitykseen (engl. cross-development). 

 

 Eclipse IDE -lisäosa mahdollistaa Yocto-projektin hyödyntämisen Eclipse IDE 

-kehitystyökalusta käsin suoraan. Sovelluksia voidaan ristikääntää ja testata 

esim. Qemussa tai fyysisessä laitteessa (esim. Raspberry Pi). Qemu (Quick 

Emulator) on ohjelmallisesti toteutettu virtuaalinen laitepohja, joka jäljittelee 

(emuloi) jotain haluttua laitearkkitehtuuria. 
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 Toaster on graafinen käyttöliittymä Yocto-projektin toimintojen hyödyntämi-

seksi selaimen avulla. 

 2.1.2 OpenEmbedded luo perustan Yocto-projektille 

OpenEmbedded-projekti sulautettiin Yocto-projektiin maaliskuussa 2011. Se tukee hy-

vin monenlaisia laitearkkitehtuureja, ja sen työkaluilla voidaan luoda vaikka kokonaan 

uusi Linux-jakelu (engl. distro), sillä se kykenee ristikääntämään tuhansia erilaisia oh-

jelmistopaketteja. OpenEmbedded mahdollistaa myös käännös- ja koontiprosessin 

nopeuttamisen, kun jokin projekti täytyy suorittaa uudelleen asetuksiin tai koodiin tehty-

jen muutosten vuoksi [13]. 

 2.1.3 Poky tekee raskaan työn 

Poky on Yocto-projektin varsinainen käännösjärjestelmä, joka muodostaa tarvittavat 

Linux-järjestelmätiedostot kuten ytimen (engl. kernel) ja muita sovelluskokonaisuuksia 

halutulle kohdearkkitehtuurille [14]. 

Alkuaan Poky oli OpenEmbedded-projektin rinnakkainen kehityshaara mutta pienempi 

ja rajoittuneempi. Sitä tuki voimakkaasti sen pääkehittäjä Richard Burdie, ja projekti 

keskittyi vain joihinkin erityisiin tehtäviin toisin kuin OpenEmbedded. Sen sanottiin ylei-

sesti olevan itsenäinen ja oma käännösjärjestelmänsä, mutta tosiasiallisesti Poky käytti 

aina bitbake ja OpenEmbedded -arkkitehtuureja, ja oli täysin vastaava sen kanssa [15]. 

Yocto-projektin luomisen yhteydessä OpenEmbedded jaettiin useisiin eri komponent-

teihin, kuten OpenEmbedded-Core ja Meta-OpenEmbedded. Samassa yhteydessä 

Pokysta tuli Yocto-projektin viitejakelu [15]. Nyt kun eri järjestelmiä on liitetty Yocto 

-projektiin, saattaa asiaa koskevista lähdemateriaaleista huomata, miten termien merki-

tys ja käyttö vaihtelee jonkin verran riippuen siitä, milloin dokumentti on kirjoitettu tai 

mistä näkökulmasta asiaa esitellään. 

Poky sisältää myös paljon tehtävien toteutuksessa ja kääntämisessä tarvittavia ase-

tusmäärittelyjä, joita kutsutaan nimellä metadata tai meta-poky. Meta-poky tarkoittaa 

Poky-järjestelmän erityistä määrittelyosiota (engl. Poky-specific metadata). 
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Metadata tarkoittaa tehtävien määrittelyjä (engl. task definitions) eli ”mitä käännetään ja 

miten”. Se sisältää mm. seuraavia asioita [14]: 

 konfiguraatiot (muuttujien määrittelyt ym.) 

 

 luokat (engl. classes, tiedostot joiden päätteenä on bbclass), jotka sisältävät tie-

toa ja määrittelyjä ominaisuuksien periytymisestä, käännöslogiikasta ja ohjel-

mapakettien koostamisesta. Luokat sisältävät suuren osan ”raskaista” tehtävis-

tä, kuten esim. määrittelyt siitä, miten Linux-ydin käännetään tai miten tiedosto-

järjestelmä rakennetaan 

 

 reseptit (engl. recipes), jotka ovat loogisia ohjeistuksia (”reseptejä”) siitä, miten 

jokin ohjelmiston osa-alue muodostetaan. Reseptit sisältävät myös yksittäisiä 

käännettäviä ohjelmakoodeja sekä ohjeita siitä, mitä paketteja asennetaan 

muodostettavaan Linux-järjestelmään. 

2.2  Ohjelmistokehitysjärjestelmää on uudistettu 

Yocto-projekti on syntyvaiheidensa jälkeen muuttunut ja kehittynyt, ja siitä on julkaistu 

useita versioita. Tällä hetkellä (huhtikuu 2019) uusin versio on 2.7.0 (Warrior). Ennen 

version 2.0 julkaisua sovellusten kehitysjärjestelmä oli nimeltään ADT (Application De-

velopment Toolkit), jonka lisäksi saatavilla oli ristikehitystyökalu sekä muutamia muita 

työkaluja [16]. Yocto-projektin version 2.1 julkaisun myötä sovelluskehitys muuttui ni-

melle SDK (Software Development Kit), josta nykyään on jo kaksi eri versiota. Näistä 

varhaisempi Standard SDK on toiminnoiltaan rajoitetumpi kuin uudempi ja monipuoli-

sempi Extensible SDK (eSDK) [16], jota myös tässä työssä käytetään. Yleisnimitykse-

nä käytetään usein kuitenkin vain lyhennettä SDK. Tarkempia nimityksiä käytetään, 

kun on tarve tehdä ero eri versioiden välillä tai jos on epäselvää kumpaa tarkoitetaan.   

Yocto eSDK on monilta osin parempi ja monipuolisempi kuin edeltäjänsä, joten sen 

käyttö on ehdottomasti järkevä valinta. Erittäin tärkeä ja keskeinen työkalu on devtool 

(ks. luku 2.1.1), joka ei sisälly vanhempaan versioon. Taulukossa 1 on vertailtu näitä 

kahta järjestelmää tärkeimpien ominaisuuksiensa osalta [16]. Taulukko on esitetty al-

kuperäisessä muodossaan englannin kielellä ilmaisujen tiiviyden ja tarkkuuden vuoksi. 
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Taulukko 1. Taulukosta voidaan havaita, että eSDK sisältää useita ominaisuuksia, joita Stan-
dard -versiossa ei vielä ollut. Devtool-työkalun lisäksi on huomattavana parannuksena mahdolli-
suus luoda kokonainen käyttöjärjestelmä (engl. build images). Tällöin Yocto-projektia ei välttä-
mättä tarvita, vaan kehitystyön kaikki osa-alueet voidaan hoitaa eSDK-järjestelmällä [16]. 

Feature 
Standard 
SDK 

Extensible SDK 

Toolchain Yes Yes (only full installation) 

Debugger Yes Yes (only full installation) 

Size 100+ MBytes 
1+ GBytes (or 300+ MBytes for minimal 
w/toolchain) 

devtool No Yes 

Build Images No Yes 

Updateable No Yes 

Managed Sysroot No Yes (through the use of devtool) 

Installed Packages No Yes 

Construction Packages Shared State 

     

3.2 Pieni mutta pippurinen Raspberry Pi 

Tässä työssä kohdelaitteena käytetyn Raspberry Pi:n ”tarina” ansaitsee pienen ”eks-

kursion”, sillä se on mielenkiintoinen kertomus siitä, miten jostain pienestä alusta voi 

räjähdysmäisesti kasvaa jotain yllättävää ja suurta.  Raspberry Pi on tänä päivänä tullut 

suosituksi paljolti muussakin käytössä, kuin mihin se alun perin suunniteltiin [17]. Sen 

syntyhistoria liittyy Englantiin ja Cambridgen yliopistoon, missä Eben Upton työskenteli 

tietotekniikan opetuksen johtajana v. 2006 [6,18]. Hän huomasi, kuinka monilla opiske-

lijoilla oli vain vähän kokemusta ohjelmoinnista ja että 1980-luvulla tehdyt kotitietoko-

neet eivät olleet kovin miellyttäviä käyttää. Kuitenkin monet IT-alan työntekijät opiskeli-

vat ohjelmoimaan näillä vanhoilla kotitietokoneilla. Kun tietokoneet myöhemmin kehit-

tyivät paremmiksi, monet osasivat kyllä käyttää niitä, mutta todellinen ohjelmointitaito ja 

tietokoneen tuntemus puuttuivat edelleen. 

Upton työskenteli myös Broadcomilla integroitujen piirien kehittäjänä [6,18] haluten 

kehittää tietokoneen, johon kaikilla olisi varaa ja jota opiskelijat voisivat käyttää tutki-

mustarkoituksiin. Hän tutki matkapuhelimissa käytettyä pienikokoista mutta tehokasta 

huipputekniikkaa ja loi sen pohjalta useita prototyyppejä. Upton perusti myös Raspber-

ry Pi Foundationin marraskuussa 2008 yhdessä muutaman asiantuntijan kanssa [17]. 

Raspberry Pi Foundation on Iso-Britanniassa toimiva hyväntekeväisyysjärjestö, joka 
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pyrkii saattamaan tietojenkäsittely- ja digitaalitekniikan mahdollisuudet edullisesti kaik-

kien ihmisten ulottuville ympäri maailmaa [10].  

Pitkän kehitystyön ja useiden prototyyppien luomisen jälkeen toukokuussa 2011 tapah-

tui merkittävä käänne, kun eräs BBC:n toimittaja (Rory Cellan-Jones) laittoi blogiinsa 

videon Raspberry Pi:n protoyypistä [17]. Tieto tästä projektista levisi välittömästi kulo-

valkean tavoin, ja Raspberry Pi:n kehitystyö jatkui yhä kiihkeämmin. Lukuisia proto-

tyyppejä rakennettiin, ja tuotteen lopullinen julkistus oli suunniteltu helmikuulle 2012. 

Kävi kuitenkin ilmi, ettei suunniteltu 10 000 kappaleen erä riitä, vaan tarve ja odotus 

markkinoilla olivat ainakin 10-kertaisia. Tuotteen suosio kasvoi lopulta nopeasti niin 

suureksi, että Raspberry Pi Foundation joutui ulkoistamaan tuotannon ja jakelun eri 

yrityksille, kuten Premier Farnell Ltd ja RS Components. Kolmessa kuukaudessa laitet-

ta myytiin yli puoli miljoonaa kappaletta ja v. 2013 loppuun mennessä jo kaksi miljoo-

naa [17]. 

Laitteen suosio ei ole laskenut alkuinnostuksen jälkeen, vaan pikemmin kasvanut va-

kaasti. Edullinen ja pienikokoinen mutta kuitenkin kokoonsa nähden tehokas ja moni-

puolinen minitietokone antaa mahdollisuuksia monenlaiseen käyttöön erilaisissa ympä-

ristöissä [17]. Raspberry Pi:sta on kehitetty jo useita versioita, ja kehitystyö jatkuu edel-

leen. Huhtikuussa 2019 uusin versio on 3 B+, jota tässä opinnäytetyössä käytetään.  
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3 YOCTO SDK -SOVELLUSKEHITYSYMPÄRISTÖN 

ASENNUS JA TESTAUS 

Yocto SDK:n asennus toimivaksi sovelluskehitysympäristöksi kaikkine työkaluineen on 

hyvin monivaiheinen sarja erilaisia toimintoja. Järjestelmää on kehitetty paljon ja siitä 

on kaksi versiota. Standard SDK on vanhempi ”malli” ja siinä asennustiedosto on läh-

tökohtaisesti isompi kuin uudemmassa Extensible SDK (eSDK) -versiossa. Standard 

-versiossa kaikki työkalut tulevat automaattisesti mukana, kun taas eSDK:ssa voi 

asennustiedoston luomisvaiheessa valita myös pienemmän (minimal) version. Minimal 

-versiossa tarpeettomat työkalut karsitaan pois niin, että tiedoston kooksi tulee vain n. 

30 Mt. Täydessä versiossa (full) kaikki työkalut ovat mukana, ja tiedoston koko on lä-

hes 1 Gt. Muitakin variaatioita näiden kahden ääripään väliltä voidaan luoda, mikäli 

mukaan halutaan vain joitain tiettyjä työkaluja [19]. 

Eri versioita vertaillessa voi taulukon 1 perusteella havaita monia syitä, miksi eSDK on 

suositeltavampi vaihtoehto. Monien uusien ominaisuuksiensa lisäksi se on myös päivi-

tettävissä toisin kuin Standard SDK sekä myös laajennettavissa erilaisten lisäpakettien 

asennuksen kautta [19, 20]. 

3.1 Asennusympäristön selvittäminen 

Asennusta varten on ensin selvitettävä kohdejärjestelmän (engl. target) ja isäntäjärjes-

telmän (engl. host) prosessoriarkkitehtuurit. Kohdejärjestelmä on se, mihin varsinaisia 

sovelluksia tai ohjelmistoja kehitetään ja isäntäjärjestelmä puolestaan se, missä ympä-

ristössä ohjelmistokehitysjärjestelmä itse toimii. Koska sulautettujen järjestelmien kehi-

tystyössä isäntä- ja kohdejärjestelmä ovat usein erilaisia, täytyy ohjelmistokehitysjärjes-

telmän kyetä kääntämään sovellus kohdejärjestelmään sopivaksi. Tällaisesta ohjelmis-

tokehityksestä käytetään termiä ristikehitys (engl. cross-development) [10]. 

Ohjelmiston kehitys- ja käännöstyössä tarvitaan aina monenlaisia työkaluja, jotka 

yleensä sisältyvät automaattisesti käännöstyön suorittavaan ohjelmistokokonaisuuteen. 

Niitä ovat mm. kohdejärjestelmän kirjastotiedostot (engl. libraries), kääntäjä (engl. 

compiler), linkitin (engl. linker) ja virheenjäljitin (engl. debugger). Ristikehityksessä tar-

vitaan vastaavia, mutta juuri tätä erityistä tarkoitusta varten suunniteltuja työkaluja 
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(engl. cross-compiler jne.). Nämä kaikki sisältyvät Yocto-projektin avulla luotavan 

eSDK:n asennustiedoston täyteen versioon. Asennustiedostoa luotaessa täytyy määri-

tellä kaikki tarvittavat muuttujat local.conf -tiedostossa. Muuttujan SDK_EXT_TYPE  

-arvo ”full” määrittelee laajimman työkaluvalikoiman sisällytettäväksi asennustiedos-

toon. Oletusarvona tosin on ”full”, vaikkei sitä huomaisi erikseen määritelläkään [19].  

SDK_EXT_TYPE = "full" 

Mikäli Yocto SDK asennetaan toiselle laitteelle, jossa on erilainen prosessoriarkkiteh-

tuuri kuin missä Yocto-projekti toimii, täytyy määritellä muuttuja SDKMACHINE [16]. 

Oletusarvona tällä muuttujalla oli i686, joka tarkoittaa 32-bittistä x86-järjestelmää. Ky-

symysmerkki (ks. alla) ennen yhtäläisyysmerkkiä tarkoittaa oletusarvoa. Ellei muuta 

arvoa määritellä, kuten tässä seuraavalla rivillä, oletusarvo jää voimaan. Jos järjestel-

mä halutaan muuttaa 64-bittiseksi, täytyy arvoksi antaa x86_64. 

#SDKMACHINE?="i686"  

SDKMACHINE = ”x86_64” 

Kohdelaitteen arkkitehtuuri määritellään muuttujalla MACHINE (tässä Raspberry Pi 3). 

Asennustiedostoon sisällytetään kaikki tarvittavat työkalut ja kaikki kääntäjän tarvitse-

ma tieto kohdearkkitehtuurista [16]. 

MACHINE = "raspberrypi3" 

3.2 Asennustiedoston luominen 

Kun kaikki muuttujat on määritelty, Yocto SDK:n asennustiedosto luodaan bitbake  

-ohjelmalla. Asennustiedoston voi myös ladata Internetistä, mikäli tarvittava tiedosto 

löytyy osoitteesta http://downloads.yoctoproject.org/releases. Tässä opinnäytetyössä 

asennustiedosto luotiin kuitenkin Yocto-projektin avulla, kun luvussa 3.1 mainitut muut-

tujat oli asetettu. Yocto-projektin asennus oli jo ennalta suoritettu. Asennustiedostoa 

luotaessa on huomattava, että eSDK:ta varten komennon lopussa täytyy olla pääte 

_ext (extensible). Tarvittava komento on Yocto-projektissa hyvin yksinkertainen [21]. 

$ bitbake <image> -c populate_sdk_ext 

Image-määrite voi olla esim. ”core-image-minimal”, joka on pienin versio käynnisty-

mään (engl. boot) kykenevästä Linux-järjestelmästä. Monipuolisempi (mutta myös 
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isompi) versio olisi ”core-image-full-cmdline”, mutta tässä työssä käytettiin pienempää 

versiota. Asennustiedoston luominen saattaa ensimmäisellä kerralla kestää koneen 

tehoista riippuen jopa useita tunteja, joten se on kätevää laittaa ”valmistumaan” vaikka 

yöaikaan, kuten itse Yocto-projektin asennuskin. Kun asennustiedosto on valmis, se 

löytyy Yocto-projektin kansiosta ~build/tmp/deploy/sdk ja sen tunnistaa tiedostopäät-

teestä sh. Nimi on yleensä pitkä sisältäen sekä isäntä- että kohdearkkitehtuurin määri-

telmät. Tässä työssä tiedoston nimi oli seuraava: 

poky-glibc-x86_64-core-image-minimal-cortexa7hf-neon-vfpv4-toolchain-ext-2.5.1.sh 

jossa ”x86_64” tarkoittaa Isäntäarkkitehtuuria ja ”cortexa7hf” kohdearkkitehtuuria. 

3.3 Yocto SDK:n asennus ja tarvittavat lisätyökalut 

Yocto SDK:n isäntäjärjestelmänä tässä työssä oli Linux Ubuntu 18.04.2 (Bionic Beaver) 

asennettuna Oracle VirtualBox:iin. Aluksi järjestelmään täytyi asentaa erilaisia kään-

nös- ja koontiprosessissa tarvittavia työkaluja kuten Python ja gawk sekä grafiikkaa ja 

Eclipse IDE -lisäosaa varten xterm [22]. Nämä asennettiin seuraavilla komennoilla:                        

$ sudo apt-get update 

$ sudo apt-get install -y gawk wget git-core diffstat unzip texinfo gcc-multilib \ 

     build-essential chrpath socat cpio python python3 python3-pip python3-pexpect \ 

     xz-utils debianutils iputils-ping libsdl1.2-dev xterm 

Tämän jälkeen eSDK:n asennustiedosto kopioitiin isäntäjärjestelmään, lisättiin oikeus 

suorittamiseen sekä suoritettiin asennus.  

$./poky-glibc-x86_64-core-image-minimal-cortexa7hf-neon-vfpv4-toolchain-ext-2.5.1.sh 

Asennuksen sijainniksi valittiin oletuskansio poky_skd, ja prosessin kesto oli vähän alle 

tunnin. Komentoriville tuli varoituksia siitä, ettei isäntäjärjestelmän yhteensopivuutta ole 

täysin testattu. Kaikki toimi kuitenkin hyvin, sillä varsinaisia virheilmoituksia ei tullut. 
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3.4  Qemu ja Raspberry Pi testaus- ja käyttöympäristöinä 

Kun Yocto SDK asennetaan ja sovelluksia aletaan kehittää, tarvitaan testiympäristöksi 

joko fyysinen laite kuten Raspberry Pi tai virtuaalinen laite Qemu. Molemmat tarvitsevat 

toimiakseen käyttöjärjestelmän, joka voidaan luoda Yocto SDK:lla. Kuvassa 4 on hah-

moteltu erilaisia Yocto SDK:n asennus-, ohjelmointi- ja testausvaiheen etenemistapoja. 

 

Kuva 4. Yocto SDK -järjestelmän asennus, käyttöönotto, sovellusten kehitys ja testaus on kaik-
kineen monivaiheinen projekti ja siinä on useita vaihtoehtoisia etenemistapoja. Tässä työssä 
edettiin punaisen viivan osoittamaa linjaa myöden. Ohjelmakoodia testattiin työstämisvaiheessa 
Qemussa Eclipse IDE:n debug-komennon avulla [23]. 
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Qemu (Quick Emulator) on ohjelmallisesti toteutettu virtuaalinen laitepohja, joka ni-

mensä mukaisesti emuloi (jäljittelee) jotain tiettyä laitearkkitehtuuria. Tässä tapaukses-

sa emuloitava arkkitehtuuri on arm, jota käytetään juuri Raspberry Pi -piireissä. Ohjel-

makoodia on toki tarkoituksenmukaista testata myös fyysisessä kohdelaitteessa, ja niin 

tässä opinnäytetyössä tehdäänkin, mutta esimerkin vuoksi on haluttu käyttää testialus-

tana myös Qemua. Tämän vaihtoehdon esille tuominen on hyödyllistä myös siksi, että 

samaa menetelmää voidaan käyttää monelle muullekin laitearkkitehtuurille. Jos kohde-

laitetta ei ole fyysisesti saatavilla testaushetkellä, mutta kyseiselle laitearkkitehtuurille 

on olemassa emulaattori, voidaan ohjelmia testata siinä. Tarvittavat työkalut ja järjes-

telmätiedostot on tietysti luotava ja asennettava ensin. 

Eclipse IDE on mahdollista integroida järjestelmään osaksi kehitysprosessia, ja tämä 

esitelläänkin tarkemmin kappaleessa 3.5. 

3.4.1 Qemun järjestelmätiedostot 

Kun eSDK-kehitysympäristö on asennettu ja Qemun käyttöönottoa valmistellaan, on 

halutulle arkkitehtuurille ensin luotava Linux-ydin (engl. kernel) ja tiedostojärjestelmä 

(engl. root filesystem). Näiden avulla Qemu kykenee käynnistymään ja ohjelmistoja 

voidaan testata siinä. Tämä Linux-järjestelmätiedostojen (engl. image) luominen tapah-

tuu samalla tavalla kuin Yocto-projektissakin. Itse asiassa eSDK toimii samalla tavalla 

kuin Yocto-projekti ja kykenee kääntämään Linux-ytimen ja muut tarvittavat tiedostot 

yhtäläisesti. 

Ennen Linux-ytimen ja tiedostojärjestelmän luomista täytyy asettaa tarvittavat muuttujat 

local.conf -tiedostoon [24]. 

 MACHINE = ”qemuarm”  

 tämä määrittelee halutun kohdelaitteen ja -arkkitehtuurin, jotka tässä tapauk-

sessa ovat Qemu ja arm. Local.conf -tiedostossa on valmiina automaattisesti 

luotu lista tarjolla olevista Qemu-laitteista ja muuttuja-arvoista, joista valitaan 

sopiva. 

EXTRA_IMAGE_FEATURES += " debug-tweaks eclipse-debug tools-debug tools-sdk 

ssh-server-openssh " 
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 tähän muuttujaan voidaan asettaa Linux-tiedostojärjestelmään asennettavat li-

sätyökalut, -ominaisuudet ja palvelut. Ssh-palvelinta tarvitaan yhteyden luomi-

seen isäntäjärjestelmästä (engl. host) Qemuun (engl. guest) ja sitä kautta tes-

tiohjelmien asennusta varten mm. devtool deploy-target -komennolla.  

IMAGE_INSTALL_append = " kernel-image kernel-devicetree tcf-agent openssh-sftp-

server"  

 TCF (Target Communication Framework) on verkkoprotokolla sulautettujen 

kohdejärjestelmien ajamiseksi. Eclipse IDE tarvitsee sitä debug-toiminnon suo-

rittamiseksi. 

Kun edellä mainitut muuttujat on asetettu, voidaan prosessi käynnistää bitbake 

-komennolla. Komentorivillä siirrytään eSDK:n asennuskansioon, joka tässä työssä on 

oletuskansio poky_sdk. Ennen bitbake-ohjelman käyttöä täytyy kuitenkin asettaa ympä-

ristömuuttujat source-komennolla. 

§ source layers/poky/oe-init-build-env 

§ bitbake core-image-minimal 

Tämä komento luo sekä Linux-ytimen että tiedostojärjestelmän ja muutamia muita tie-

dostoja. Kun tämä toteutetaan ensimmäistä kertaa, voi koko prosessiin kulua useita 

tunteja riippuen isäntäjärjestelmän tehosta. 

Kun prosessi on valmis, löytyvät halutut tiedostot kansiosta ~poky_sdk/build/tmp 

/deploy/images/gemuarm. Linux-ydin on n. 5 megatavun kokoinen tiedosto ja tässä 

työssä sen nimi oli ”zImage-qemuarm.bin”. Tätä tietoa tarvitaan myöhemmin Eclipsen 

ja Yocto SDK:n yhteistoimintaa konfiguroitaessa. Toinen tarvittava tiedosto on tiedosto-

järjestelmä, joka tässä työssä oli nimeltään ”core-image-minimal-qemuarm-

20190416203228.rootfs.tar.bz2”. Se on pakattu tiedosto, joka sisältää mm. ristikääntä-

jän (engl. cross compiler) tarvitsemat tärkeät järjestelmäkirjastot yms. 

Tiedostojärjestelmä täytyy purkaa, jotta Eclipse IDE löytää kohdelaitteen sysroot 

-järjestelmän ja pystyy käyttämään ristikääntäjää [23]. Tässä työssä noudatettiin suosi-

tuksia purkamalla se kansioon ~build/MY_QEMU_ROOTFS. Tiedoston purkamiseen 

on olemassa erityinen työkalu runqemu-extract-sdk kansiossa po-

ky_sdk/sysroots/x86_64-pokysdk-linux/usr/bin. Komento, jolla purku suoritetaan, on 
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varsin pitkä ja sisältää polut suoritettavaan ohjelmaan, purettavaan tiedostoon sekä 

kohdekansioon. Kokonaisuudessaan se oli seuraava. 

$ /home/rauno/poky_sdk/sysroots/x86_64-pokysdk-linux/usr/bin/runqemu-extract-sdk 

core-image-minimal-qemuarm-20190416203228.rootfs.tar.bz2 

/home/rauno/poky_sdk/build/MY_QEMU_ROOTFS 

Qemun toiminta testattiin tässä vaiheessa käynnistämällä se komennolla runqemu 

<target>. Komennossa target on polku kansioon, jossa ovat Qemun tarvitsemat järjes-

telmätiedostot (ydin ja tiedostojärjestelmä). Tämä suoritettiin eri terminaalissa kuin bit-

bake, sillä tarvittavat ympäristömuuttujat ovat erilaiset. 

$ source environment-setup-cortexa7hf-neon-vfpv4-poky-linux-gnueabi 

$ runqemu qemuarm /home/rauno/poky_sdk/build/tmp/deploy/images/qemuarm 

3.4.2 Käyttöjärjestelmä Raspberry Pi -piirille 

Raspberry Pi -piiriä varten luotiin omat järjestelmätiedostonsa samalla tavoin kuin Qe-

mulle kappaleessa 3.4.1. Muuttujat local.conf -tiedostossa määriteltiin uudelleen seu-

raavalla tavalla: 

MACHINE = "raspberrypi3"  

IMAGE_FSTYPES = "ext4 rpi-sdimg" 

 

MACHINE-muuttuja määrittelee kohdelaitteen ja IMAGE_FSTYPES (=Image File Sys-

tem Types) puolestaan tiedostojärjestelmätyypin ja millaisen paketin ohjelma tuottaa. 

Tässä ext4 on Linux-järjestelmissä yleisimmin käytetty tiedostojärjestelmä ja rpi-sdimg 

tarkoittaa, että tuotetaan Raspberry Pi -piiriä varten SD-kortille asennettavaksi sopiva 

paketti. Tuossa paketissa on mukana ydin, tiedostojärjestelmä ja osioiden asettelutie-

dot (engl. partition layout). Paketti purettiin ja asennettiin SD-kortille Etcher-ohjelmalla, 

joka on saatavissa myös Windows käyttöjärjestelmälle. Asennuksen jälkeen järjestel-

män toiminta testattiin vielä käynnistämällä Raspberry Pi.  
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3.5 Eclipse IDE:n ja Yocto-lisäosan asennus ja testaus 

Eclipse IDE on avoimen lähdekoodin ohjelmointityökalu sovellusten kehittämiseen hy-

vin monenlaisilla ohjelmointikielillä (mm. Java, C, C++, PHP). Eclipse IDE on myös 

saatavilla erilaisille käyttöjärjestelmille (Windows, Linux, Mac OS), ja siihen saa asen-

nettua hyvin monenlaisia lisäosia (engl. plug-in) muita järjestelmiä kuten tässä työssä 

käytettyä Yocto-projektia varten. Tässä luvussa esitetty Eclipse IDE:n konfigurointi 

noudattaa pääpiirteissään lähteenä käytetyn Yocto-projektin manuaalin [23] ohjeita, 

eikä joka kohdassa ole siksi erikseen merkitty viitenumeroa.  

Eclipse IDE on toteutettu pääasiassa Java-ohjelmointikielellä ja tarvitsee toimiakseen 

Java-ympäristöä. Tässä työssä asenettiin versio openjdk-8. 

$ sudo apt-get update 

$ sudo apt install openjdk-8-jdk 

3.5.1 Eclipse IDE:n asennus 

Eclipse IDE asennetaan aina omana versionaan eri ohjelmointikieliä varten (tässä 

C++). Asennuksessa käytettiin Ubuntu Make -ohjelmaa, joka on kehitetty eri ohjelmien 

helppoa asennusta varten [25]. Yhdellä komennolla se lataa lähdekoodipaketin ja kaik-

ki riippuvuudet, kääntää lähdekoodin sekä lisää työpöydän käynnistyskuvakkeen. 

Ubuntu Make ja Eclipse IDE:n uusin versio 2019-03 (4.11.0) asennettiin seuraavasti: 

$ sudo apt-get update 

$ snap install ubuntu-make -classic 

$ ubuntu-make.umake ide eclipse-cpp 

3.5.2 Yocto-lisäosan asennus 

Eclipse IDE:n integroimiseksi Yocto SDK -järjestelmään asennettiin siihen Yocto 

-lisäosa. Valikosta ”Help > Install New Software > Add” avautuvan ikkunan location 

-ruutuun asetettiin uusimman lisäosan URL-osoite (kuva 5). Tämän jälkeen hyväksyttiin 

kaikki asennetavat paketit sekä käynnistettiin Eclipse IDE uudelleen. 
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Kuva 5. Eclipse IDE kuvakaappaus. Yocto-lisäosa ladataan osoitteesta 
http://downloads.yoctoproject.org/releases/eclipse-plugin/2.6.1/oxygen. 

3.5.3 Eclipse IDE:n ja Yocto-lisäosan konfigurointi 

Yocto-lisäosa konfiguroitiin avaamalla valikko ”Window > Preferences” ja valitsemalla 

vasemmasta sivupalkista juuri asennettu Yocto-lisäosa. Avautuvassa ikkunassa (kuva 

6) määritellään Linux-ytimen ja kohdelaitteen tiedostojärjestelmän sijainnit sekä muut 

perusasetukset, joista ensimmäinen ja merkittävin on työkalukokonaisuuden valinta. 

Tarjolla on kaksi vaihtoehtoa: "Standalone pre-built toolchain” ja “Build System Derived 

Toolchain”, joista jälkimmäinen on oletuksena, ja sitä myös tässä työssä käytettiin. En-

simmäistä vaihtoehtoa voi käyttää, jos tarkoitus ei ole tehdä kohdelaitteen käyttöjärjes-

telmää ja työkaluvalikoima on ladattu erikseen. Jälkimmäistä käytetään, kun työkaluva-

likoima on tehty osana käännösprosessia, kuten tässä työssä. 

 

Kuva 6. Eclipse IDE kuvakaappaus. 
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Toolchain Root Location -ruudussa määritellään polku bitbake-komennon suoritusha-

kemistoon (~poky_sdk/build).  

Sysroot Location tarkoittaa polkua sysroot-hakemistoon ~build/MY_QEMU_ROOTFS, 

jonne Qemua varten luotu järjestelmätiedosto aiemmin purettiin (luku 3.4.1). 

Myös kohde (Target Architecture, kuvassa 6 sininen kehys) määritellään sen mukaan, 

mitä laitearkkitehtuuria aiotaan emuloida. Alasvetovalikosta tulee esiin tarjolla olevat 

vaihtoehdot, joita tässä tapauksessa oli vain yksi eli ”armv5e-poky-linux-gnueabi”. Lo-

puksi valitaan vielä, käytetäänkö kohdejärjestelmänä Qemua vai ulkoista fyysistä laitet-

ta. Tässä työssä käytettiin Qemua ohjelmoinnin yhteydessä testiympäristönä ja asetuk-

siin täytyi siksi määritellä polku Qemua varten tehtyyn Linux-ytimeen (kuvassa 6 punai-

nen kehys). Custom option -asetusta tarvitaan, jos Qemulle halutaan antaa jotain lisä-

määritteitä, mutta tässä tapauksessa se jätettiin tyhjäksi. 

3.5.4 Hello World -testiohjelman käyttö 

Eclipse IDE:n ja Yocto eSDK:n asennus ja yhteistoiminnan käyttöönotto on monivai-

heinen prosessi, jossa on huomioitava paljon yksityiskohtia. Tätä yhteistoimintaa testat-

tiin aluksi Eclipsestä löytyvällä valmiilla Hello World -malliprojektilla valitsemalla "File > 

New > C/C++ Project > Next > C Managed Build > Next” ja laajentamalla valikko "Yoc-

to Project SDK Autotools Project". Sitten valittiin "Hello World ANSI C Autotools Pro-

jects" (kuva 7), joka on C-kielellä toteutettu malli ja jolla pääsee helposti ohjelmoinnin 

alkuun. Projektille annettiin nimi HelloTest, ja toiminto viimeisteltiin painamalla Finish.  

 

Kuva 7. Eclipse IDE kuvakaappaus. 
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Qemun toiminta yhdessä Eclipse IDE:n kanssa onnistuu debug-tilassa, jolloin Qemu 

käynnistetään Eclipse IDE:stä suoraan, ja käännetty ohjelma asennetaan samalla Qe-

muun. Tämän toteuttamiseksi täytyi tehdä vielä useita asetuksia niin Eclipse IDE:ssä 

kuin isäntäkoneessakin. Ensin tarkistettiin onko isäntäjärjestelmään asennettu rpcbind. 

Rpcbind-apuohjelma on palvelu, joka muuntaa RPC-ohjelmien numerot universaaleiksi 

osoitteiksi. Sen on oltava käynnissä isäntälaitteessa, jotta se voi tehdä RPC-

yhteydenottoja. Ohjelman toiminta tarkistettiin ja todettiin, ettei sitä oltu asennettu. Tar-

kistus ja asennus suoritettiin seuraavilla komennoilla: 

$ sudo service rpcbind status 

$ sudo apt-get install rpcbind 

Asentamisen jälkeen täytyi vielä muokata tiedostoa /etc/init.d/rpcbind siten, että siellä 

on seuraava rivi: 

OPTIONS="-i -w" 

Rivi oli kyllä jo olemassa, mutta siitä puuttui i-kirjain. Muokkauksen jälkeen palvelu täy-

tyi käynnistää uudelleen komennolla: 

$ sudo service portmap restart           

Kun rpcbind-palvelu oli näin kunnossa, avattiin Eclipse IDE:stä valikko ”Run > External 

Tools > External Tools Configurations“ (kuva 8) ja valittiin vasemmalta valikkopalkista  

kohdearkkitehtuurin työkaluohjelmisto. 

 

Kuva 8. Eclipse IDE kuvakaappaus. 
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Qemu käynnistyy komennolla Run (paneelin alalaidassa) ja ensin avautuu xterm 

-terminaaliemulaattori, johon täytyy antaa oman Linux-järjestelmän salasana. Vasta 

sen jälkeen Qemu käynnistyy tty1-terminaalissa, ja käyttäjätunnuksella root pääsee 

sisään. Qemun IP-osoitteen voi tarkistaa komennolla ifconfig, mutta se näkyy myös 

xterm-terminaaliemulaattorissa. Se on yleensä 192.168.7.2, ellei mitään poikkeavaa 

ole tapahtunut.  

Kun Qemu on käynnistynyt, siihen otetaan isäntäkoneen terminaalista ssh-yhteys: 

$ ssh -XY root@192.168.7.2 

Seuraavaksi asetetaan komento export DISPLAY=:10.0 suoritettavaksi ennen sovel-

luksen käynnistymistä (kuva 9). 

 

Kuva 9. Eclipse IDE kuvakaappaus. 

Ssh-yhteys täytyi pitää toiminnassa tämän jälkeen koko prosessin ajan. Seuraavaksi 

avattiin valikko ”Run > Debug Configuration” ja vasemmalta valikkopalkista laajennettiin 

"C/C++Remote Application" ja valittiin oma projekti (kuva 10). Projektin asetusnäkymän 

Debugger-välilehdeltä tarkistettiin käytössä oleva virheenjäljitin (engl. debugger), ja 

Main-välilehdellä luotiin uusi yhteys valitsemalla New. 
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Kuva 10. Eclipse IDE kuvakaappaus. 

Yhteydeksi asetettiin ssh, nimeksi TestiYhteys, Host-ruutuun Qemun IP-osoite ja käyt-

täjäksi root (kuva 11). Salasana-ruutu jätettiin tyhjäksi ja lopuksi valittiin Finish sekä 

varmistettiin vielä main-näkymän alasvetovalikosta (Connection), että haluttu yhteys on 

valittuna (kuva 10). 

 

Kuva 11. Eclipse IDE kuvakaappaus. 
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Kohdejärjestelmästä (Qemu) valitaan haluttu sijainti asennettavalle ohjelmalle joko 

Browse-komennolla selaamalla tai kirjoittamalla suoraan halutun kansion polku ja oh-

jelman nimi (kuva 12). Kansion olemassaolo ja polun oikeellisuus on syytä varmistaa. 

Tässä ohjelman asennuskansioksi valittiin /home/root ja nimeksi HelloTest. 

 

Kuva 12. Eclipse IDE kuvakaappaus. 

Eclipse IDE:ssä täytyy asettaa Debug-perspektiivi, kun ohjelma kysyy siihen siirtymistä. 

Mikäli se ei sitä automaattisesti kysy, niin tuo muutos tehdään itse avaamalla valikko 

”Window > Perspective > Open Perspective > Other” ja valitsemalla avautuvasta nä-

kymästä Debug ja Open. Sen jälkeen valikosta ”Run > Debug Configurations” valitaan 

Debug, jolloin ohjelma käännetään ja asennetaan Qemuun ssh-yhteyttä käyttäen. Sen 

jälkeen voi testiohjelmaa kokeilla joko isäntäjärjestelmän terminaalissa tai Qemussa 

suoraan. Tässä työssä ohjelmaa testattiin Qemun terminaalissa (kuva 13). 

 

Kuva 13. Kuvakaappaus Qemu-terminaalista. HelloTest-ohjelma tulostaa ruudulle lauseen ”Hel-
lo World testi toimii”. 



30 

TURUN AMK:N OPINNÄYTETYÖ | Rauno Vesti 

Edellä kuvattu ohjelmakoodin testaus suoraan Eclipsen Debug-komennolla vaatii mo-

nia asetuksia Eclipse IDE:ssä, mutta on toisaalta kätevä tapa, jos koodin toimivuutta 

halutaan nopeasti testata, eikä fyysistä laitetta ole saatavilla. Toinen tapa toteuttaa 

testaus olisi luoda projektista devtool-työkalulla (luvussa 4 tarkemmin) esim. hello-

niminen resepti, joka käännetään ja asennetaan Qemuun seuraavilla komennoilla.  

$ devtool add hello /home/rauno/eclipse-workspace/HelloWorld 

$ devtool build hello 

$ devtool deploy-target -c -s hello root@192.168.7.2 

Tämä testaustapa ei ole yhtä nopea, sillä Eclipse IDE:stä käsin voi ohjelmaa testata 

helposti moneen kertaan ohjelmoinnin aikana valikosta ”Run > Run Configurations” 

komennolla Run, jolloin ohjelman tuotos tulostuu Eclipse IDE:n konsoliin. Näiden eri 

järjestelmien (Eclipse IDE ja Yocto SDK) yhteistoiminnassa tosin ajoittain esiintyy on-

gelmia, jotka mahdollisesti aiheutuvat Yocto-projektin nopeasta kehitysvauhdista. 
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4 OHJELMISTOTUOTANTO YOCTO SDK  

-KEHITYSYMPÄRISTÖSSÄ 

4.1 Tarvittavat ohjelmat ja laitteet 

Tässä opinnäytetyössä käytettiin seuraavia ohjelma- tai järjestelmäversioita ja laitteita:  

 PC-tietokone x86_64 prosessoriarkkitehtuurilla 

 Oracle VirtualBox 5.2.28 

 Linux Ubuntu 18.04.2 

 Yocto Project (2.5.1, sumo) 

 Eclipse IDE 2019-03 (4.11.0)  

 Eclipse IDE:n Yocto-lisäosa (engl. plug-in) 2.6.1/oxygen 

 Raspberry Pi 3 B+ 

Yocto-projekti ja Yocto SDK asennettiin samalle PC-tietokoneelle, mutta eri virtuaalilait-

teille, joissa molemmissa käytettiin Ubuntu 18.04.2 käyttöjärjestelmää. Raspberry Pi  

-piirille asennettiin Linux-käyttöjärjestelmä luvussa 3.4.2 kuvatulla tavalla.  

4.2 Esimerkkiohjelman koodaus ja toiminnan testaaminen 

Järjestelmän toiminnan testaamiseksi koodattiin pieni ohjelma nimeltä Yoctotesti. Oh-

jelma on erittäin yksinkertainen tietovisa, joka tulostaa ruudulle kolme kysymystä tämän 

opinnäytetyön aiheista (kuva 14) ja laskee saadut pisteet. Käyttäen C++  

-ohjelmointikieltä ja Eclipse IDE -työkalua luotiin ensin uusi projekti valikosta ”File > 

New > C/C++ Project > C++ Managed Build > Yocto Project SDK Autotools Project > 

Hello World C++ Autotools Projects". Tästä Hello World -malliprojektista muokattiin 

tietovisa, ja sitä testattiin Qemussa Eclipsen Debug-komennolla, samalla tavalla kuin 

Hello World -ohjelmaa kappaleessa 3.5.4. Ohjelma asennettiin Qemun kansioon 

/usr/bin, jolloin ohjelman voi suorittaa home-kansiosta ilman polkumäärittelyä. Eclipse 

IDE:n konsolille tulostui asennuksen etenemisen vaiheet ja lopuksi ilmoitus asennuk-

sen onnistumisesta. 
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Kuva 14. Kuvakaappaus Qemun tty1-terminaalin näytöstä Yoctotesti-pelin testausvaiheessa. 
Tietovisan ensimmäinen kysymys on ruudulla. 

4.3 Sovelluskehityksen työnkulku ja reseptin luominen 

Kuvassa 15 on Yocto SDK -kehitysympäristön työnkulku, eli se miten ohjelmien kehitys 

etenee ja mitä vaiheita siinä on. Aluksi ohjelmakoodi tuodaan järjestelmään devtool 

add -komennolla, joka automaattisesti luo koodista valmiin reseptin. Resepti sisältää 

konfigurointeja, joiden pohjalta bitbake-ohjelma osaa koostaa määritellyn ohjelmapake-

tin (ks. luku 2.1.3). Kuvan yläosassa on esitetty kolme erilaista tapaa tuoda ohjelma-

koodi. Ensimmäisessä mallissa (vasemmalla) ohjelma tuodaan verkosta (parametrinä 

vain URL-osoite) devtool-ohjelman oletustyökansioon (workspace/sources). Keskim-

mäisessä mallissa ohjelma ladataan verkosta erilliseen lähdekansioon (srctree), josta 

se noudetaan ja siitä luodaan resepti. Tässä työssä edettiin kolmannen vaihtoehdon 

mukaan, missä koodi tuodaan paikalliselta koneelta antamalla parametriksi polku 

(srctree) projektikansioon (tässä Eclipse IDE workspace). 
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Kuva 15. Yocto SDK -järjestelmän sovelluskehitysprosessin etenemismalli eli ”workflow”, jossa 
on monia eri toteutusvaihtoehtoja. Punainen viiva osoittaa miten tässä työssä edettiin. Ohjelma 
asennettiin Raspberry Pi -laitteelle (kohta 4) eikä Qemua enää tässä vaiheessa käytetty. Qe-
mua käytettiin koodin työstämisvaiheessa testaukseen. (ks. luku 3.5.4) [16]. 

Devtool-työkalu on erityisen kätevä ja säästää paljon konfigurointiin kuluvaa aikaa.  

Kun Eclipse IDE:n projektikansiosta voidaan suoraan luoda resepti, se vähentää myös 

inhimillisen virheen mahdollisuuksia. Kun resepti on valmis, se käännetään kohdejär-
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jestelmää varten toimivaksi ohjelmaksi. Tässä työssä resepti luotiin ja käännettiin seu-

raavilla komennoilla: 

$ source environment-setup-cortexa7hf-neon-vfpv4-poky-linux-gnueabi 

$ devtool add yoctotesti /home/rauno/eclipse-workspace/Yoctotesti 

$ devtool build yoctotesti 

4.4 Ohjelman asennus Raspberry Pi -laitteelle 

Reseptin kääntämisen jälkeen ohjelma voidaan asentaa ja testata joko fyysisessä lait-

teessa tai myös uudelleen Qemussa (kuva 15 kohta 4). Tässä työssä ohjelma asennet-

tiin Raspberry Pi -laitteelle. 

$ devtool deploy-target -c -s yoctotesti root@192.168.111.101 

Yllä oleva komento asentaa ohjelman kohdelaitteelle kansioon /usr/bin, joka on Linux  

-järjestelmien oletuskansio niille suoritettaville binääritiedostoille, jotka eivät ole keskei-

siä järjestelmän toiminnan kannalta. Tällöin ohjelman voi suorittaa suoraan käyttäjän 

home-kansiosta ilman polkumäärittelyä [26]. Asennuksen aikana Raspberry Pi oli liitet-

ty suoraan kannettavaan tietokoneeseen Ethernet-kaapelilla ja se sai IP-osoitteensa 

(192.168.111.101) tietokoneelle asennetulta DHCP-palvelimelta. Komennon parametri 

-c tarkoittaa, että ssh-yhteyden isäntäkoneen avaimen tarkistus poistetaan käytöstä, ja 

-s puolestaan tulee sanoista show-status, jolloin ohjelma tulostaa terminaaliin etenemi-

sensä eri vaiheet. Kun ohjelma oli asennettu, sitä testattiin ssh-yhteyden kautta root-

käyttäjän kotikansiossa komennolla Yoctotesti. 

$ ssh root@192.168.111.101 

$ Yoctotesti 

Jos toiminnassa olisi jotain vialla, niin ohjelman reseptiä voidaan muokata komennolla 

devtool edit-recipe. Muuttujalla EXTRA_OECONF voidaan lisätä tai poistaa joitain omi-

naisuuksia, jonka jälkeen resepti käännetään ja testataan, poistuiko ongelma. 

$ devtool edit-recipe yoctotesti 

Ohjelman asennus voidaan poistaa kohdelaitteelta seuraavalla komennolla: 
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$ devtool undeploy-target yoctotesti 

Jos myös koko resepti halutaan poistaa, on se syytä tehdä devtool reset -komennolla, 

eikä esim. poistaa sitä käsin workspace/recipes -kansiosta. 

$ devtool reset yoctotesti 

Kuvan 15 kaaviossa on esitetty myös vaihtoehtoinen tapa asennukselle. Mikäli luodaan 

kokonainen käyttöjärjestelmä kohdelaitteelle komennolla devtool build-image <image>, 

voidaan käyttöjärjestelmän mukana asentaa myös kaikki lisäohjelmat.  

4.5 Ohjelmistotuotannon viimeistelyvaihe 

Kun kehitetty sovellus on valmis asennettavaksi eri ohjelmistokokonaisuuksiin, on vii-

meisenä vaiheena julkaista se luomalla siitä Yocto-resepti devtool finish -komennolla 

[27]. Se on periaatteessa samanlainen kuin devtool add -komennolla luotu resepti (luku 

4.3), mutta devtool finish -komennolla resepti liitetään Yocto-kerrokseen (engl. layer), 

joko valmiiseen tai samassa yhteydessä luotavaan uuteen kerrokseen. Kerrokset ovat 

ohjelmistotuotannon lopullisia varastointipaikkoja, mistä niitä voi myöhemmin liittää 

uusiin käyttöjärjestelmiin tai asentaa valmiisiin järjestelmiin. Kerroksia liitetään bitbake 

-layers add-layer -komennolla aina kulloinkin työn alla olevaan projektiin, ja lista aktiivi-

sen projektin kerroksista muodostuu bblayers.conf -tiedostoon.  

 

Ensin luodaan siis Yocto-kerros komennolla yocto-layer create <polku kerrokseen>, 

jonne resepti siirretään devtool finish -komennolla. Tässä työssä uusi kerros luotiin 

nimellä meta-yoctotesti, sillä vakiintuneen käytännön mukaisesti kerrokset nimetään 

meta-alkuisiksi [12]. Seuraavilla komennoilla luodaan kerros nimeltään meta-yoctotesti, 

lisätään sinne yoctotesti-resepti ja lopuksi kerros lisätään aktiiviseen projektiin.  

 

$ layers/poky/scripts/yocto-layer create layers/meta-yoctotesti 

$ devtool finish yoctotesti layers/meta-yoctotesti 

$ layers/poky/bitbake/bin/bitbake-layers add-layer layers/meta-yoctotesti 

Kuvassa 16 on esitelty havainnollisesti ohjelmistotuotannon päävaiheet, joista viimei-

senä on varastoon (engl. repository) siirtäminen devtool finish -komennolla. 
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Kuva 16. Yocto SDK -sovelluskehityksen päälinjat. Viimeisenä vaiheena on valmiiden tuotosten 
julkaiseminen eli tallentaminen varastoon (engl. repository, ”Repo”) devtool finish -komennolla 
[27]. 

Edellä mainittua Yocto-projektin ohjeista poimittua komentosarjaa [20] testattaessa 

todettiin kuitenkin, ettei tarvittavaa yocto-layer-skriptiä löydy scripts-kansiosta. Syynä 

saattaa olla se, ettei sitä ole mukana kaikissa Yocto-versioissa. Niinpä kerroksen luo-

miseen käytettiinkin bitbake-komentoa. Koska bitbake käyttää eri ympäristömuuttujia 

kuin devtool, avattiin sitä varten oma terminaali, jossa suoritettiin seuraavat komennot: 

$ source layers/poky/oe-init-build-env 

$ bitbake-layers create-layer /home/rauno/poky_sdk/layers/meta-yoctotesti 

Koska devtool finish -komento käyttää git-varastoa (engl. repository) korjausten (engl. 

patch) luomiseen [28], täytyi aiemmin luotu Eclipsen projektikansio muuttaa git  

-varastoksi. Git-komennot täytyi suorittaa komentorivillä Eclipsen projektikansiossa ja 
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devtool-komento poky_sdk -kansiossa. Seuraavilla komennoilla saatiin aikaan toivottu 

lopputulos: 

$ git init 

$ git config --global user.email rauno@example.com 

$ git config --global user.name rauno 

$ git add . 

$ git commit -m "yocto” 

$ devtool finish yoctotesti layers/meta-yoctotesti 

Kuvasta 17 voidaan nähdä millaisia kerroksia Yocto-projektissa on ja miten ne on jao-

teltu. Alimpana on OE-core (OpenEmbedded-Core), joka sisältää laite- ja järjestelmä-

riippumatonta metatietoa ja on oletuksena mukana, kuten myös Yocto Layer. 

 

Kuva 17. Yocto-projektin erilaisia kerroksia. Kaksi alinta ovat oletuksena mukana ja muodosta-
vat perustan järjestelmälle. Niiden päällä on erikseen ladattavia laite- ja järjestelmäkohtaisia 
kerroksia ja ylimpänä käyttäjän itse luoma kerros, joita voi olla useitakin. Näistä valitaan haluttu 
kokoonpano kuhunkin projektiin lisäämällä niitä bitbake-layers add-layer -komennolla [29]. 

Seuraavana on laitekohtaisia kerroksia sekä ylimpänä käyttäjän itse luoma kerros. Yoc-

to-kerroksia ja -reseptejä voidaan luoda tarvittava määrä ja jaotella ne parhaaksi katso-

tulla tavalla yhteensopiviksi kokonaisuuksiksi. Eri kerrokset ja niiden reseptit ovat siten 

käytettävissä moniin tarkoituksiin, joko erillisiin ohjelma-asennuksiin tai kokonaisten 

käyttöjärjestelmien luomiseen. 
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5 LOPPUPÄÄTELMÄ JÄRJESTELMÄN TOIMINNASTA 

Tässä työssä oli tavoitteena perehtyä Yocto SDK -sovelluskehitysympäristöön, jonka 

avulla sulautettuihin järjestelmiin voidaan kehittää uusia sovelluksia tai täydellisiä Linux 

-käyttöjärjestelmiä ja jakeluversioita (engl. distro). Linux on vakiinnuttanut asemansa ja 

kasvattanut yhä suosiotaan paitsi tietotekniikassa laajemminkin, niin erityisesti sulautet-

tujen järjestelmien alalla. Tässä työssä kohdelaitteena oli Raspberry Pi -piiri, joka mo-

nipuolisuutensa ja tehokkuutensa ansiosta on myös saavuttanut laajan suosion. Linux, 

Yocto SDK ja Raspberry Pi avaavat laajat mahdollisuudet luoda monia erilaisia toimin-

nallisia järjestelmiä erityisesti IoT-teknologiassa. 

Yocto SDK:n asennus sujui täysin moitteettomasti, mutta syvällisempi perehtyminen eri 

työkaluihin ja niiden yhteistoimintaan vaatii ajoittain runsaasti aikaa ja konfigurointia. 

Tätä helpottavia työkaluja on kuitenkin kehitetty (mm. devtool), ja koko sulautettujen 

järjestelmien kehitysympäristö on muutenkin erittäin aktiivisen kehitystyön alaisena. 

Uusia ominaisuuksia luodaan säännöllisesti ja erilaisten laitearkkitehtuurien tuki on 

melko kattava. 

Kaiken kaikkiaan voitiin todeta, että Yocto-projekti ja siihen liittyvä SDK  

-kehitysympäristö kaikkine työkaluineen on erittäin kätevä ja toimiva väline sulautettu-

jen järjestelmien kehitykseen. Suhteellisen vähällä vaivalla pääsee jo alkuun hyvien 

ohjekirjojen ja malliesimerkkien avulla. Pidemmälle edetessä erilaisia uusia mahdolli-

suuksia avautuu ja järjestelmän voima on siinä, että kaikki kootaan palasista, joita voi 

yhdistellä mielensä mukaan. Järjestelmä on siis hyvin joustava ja antaa tilaa uusille 

innovaatioille. Tämän opinnäytetyön puitteissa ei ollut mahdollista perehtyä laajemmin 

eri ominaisuuksiin, mutta jo tämä lyhyt katsaus antoi kuvan hyvin toimivasta systeemis-

tä. 

Pieni haittapuoli tässä kehitystyössä ovat pitkät, joskus tuntejakin kestävät käännös- ja 

koontiprosessit. Mutta kun ne ajoittaa suunnitelmallisesti sopiviin hetkiin, jolloin voi teh-

dä jotain muuta, ei sekään aiheuta suurempaa ongelmaa. Tätäkin ongelmaa on helpo-

tettu välimuistimekanismin (sstate cache) avulla. Edistyneille kehittäjille ja ammattilaisil-

le järjestelmästä löytyy valtava määrä työkaluja ja mahdollisuuksia luoda vaikka koko-

nainen Linux-jakelu omine sovellusohjelmineen ja työpöytäympäristöineen. Tässä 

opinnäytetyössä pienen esimerkkiohjelman luominen ja asennus Yocto SDK  

-järjestelmällä Raspberry Pi -piirille sujui erinomaisesti. 
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